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1.  Overview

The ICDM-RX/TCP (DeviceMaster) and ICRPC (RocketPort EXPRESS) Windows Driver Console manual 
provides support for the following products: 
• ICRPC (RocketPort EXPRESS), including the RocketPort INFINITY, which is referred to as RocketPort in 

the manual.
• DeviceMaster (ICDM-RX/TCP), which is referred to as DeviceMaster in the manual.

Install the DeviceMaster NS-Link device driver to use the DeviceMaster serial ports as native COM ports 
and to set up secure COM ports. If you install the device driver, you can also configure the ports for socket 
mode or serial tunneling. See NS-Link Device Driver Configuration Considerations on Page 29 for detailed 
information about the NS-Link device driver.
Refer to PortVision DX Overview - DeviceMaster on Page 7 for information about an application to assist 
configuring network settings. 

1.1. Windows Driver Management Console

This manual discusses how to install and configure Pepperl+Fuchs Windows device drivers using the Windows 
Driver Management Console.
The driver installation is accessible through a dedicated shortcut created during the initial device driver 
installation process. The Windows Driver Management Console allows you to browse all installed and 
supported Pepperl+Fuchs products in one place and apply any changes quickly.
You can refer to Using the Windows Driver Management Console on Page 30 for general information.

1.2. Supported Operating Systems

The Windows Driver Management Console supports the following operating systems:
• Windows 7, Windows 8/8.1, Windows 10, and Windows 11
• Windows Server 2012R2, Windows Server 2016, Windows Server 2019, and Windows Server 2022

1.3. Products Supported

These are the products supported by the Windows Driver Management Console:
• All DeviceMaster models
• All RocketPort EXPRESS models
• All RocketPort INFINITY models
6
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1.4. PortVision DX Overview - DeviceMaster

PortVision DX automatically detects the following Ethernet attached products physically attached to the local 
network segment so that you can configure the network address, upload firmware, and manage the following 
products:
• DeviceMaster models
• ICDM-RX/EN and ICDM/RX/EN1 (DeviceMaster EtherNet/IP) models
• ICDM-RX/MOD (DeviceMaster Modbus Router/Server/TCP) models
• ICDM-RX/PN and ICDM-RX/PN1 (DeviceMaster PROFINET IO) models
• IO-Link master (ICE2x and ICE3x) models
• RocketLinx managed switches
PortVision DX may require that you have the latest Microsoft Service pack installed for your operating system.
In addition to identifying the following Ethernet attached products, you can use PortVision DX to display any 
third-party switch and hardware that may be connected directly to those devices. All non-Pepperl+Fuchs 
products and unmanaged RocketLinx devices are treated as non-intelligent devices and have limited feature 
support. For example, you cannot configure or update firmware on a third-party switch.

1.5. Download the Latest Software and Documentation

Go to https://www.pepperl-fuchs.com to locate the latest Windows device driver for your product.
7
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2.  Before Installing the DeviceMaster Driver

This section provides an overview for the procedures that you may need to perform before installing the 
DeviceMaster device driver.
This section contains the following discussions:
• Initial Installation Overview on Page 8
• Install the Hardware on Page 8
• Install PortVision DX on Page 9
• Program the IPv4 Address (Network Information) on Page 12
• Program the IPv6 Address (Network Information) on Page 14
• Check the SocketServer Version on Page 15
• Uploading SocketServer on Page 16

2.1. Initial Installation Overview

If you have already performed the following procedures, you can skip to the next section, Device Driver 
Installation on Page 17. 
You may also refer to the ICDM-RX/TCP Installation and Configuration Manual, which provides detailed 
information about the following procedures:
1. Install the hardware.
2. Install PortVision DX.
3. Program the network information using PortVision DX (Page 12).
4. Check the SocketServer version and determine whether you need to download an updated version (Page 

15).
5. If necessary, check with Technical support to get the latest version of SocketServer.

2.2. Install the Hardware

If you have not done so, install the DeviceMaster:
1. Connect an Ethernet cable between the DeviceMaster and a host PC NIC or to the same Ethernet network 

segment using a standard Ethernet cable. Refer to DeviceMaster Connectivity Requirements on Page 72 
for cabling information.

2. Connect the power supply or cable to the DeviceMaster and apply power.
3. Check the DeviceMaster LEDs to verify that it is ready. Refer to DeviceMaster LEDs on Page 72 to 

determine the LED status.
8
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2.3. Install PortVision DX

Use the following procedure to install PortVision DX.
1. Download PortVision DX from https://www.pepperl-fuchs.com.
2. Execute the PortVision_DX_[version].msi file and click Next.

3. Select I accept the terms in the License Agreement and Next to install. 
9
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4. Click Next.

5. Click Next.

6. Click Install.

7. Select Yes to the User Account Control Do you want to allow this app to make changes to your device 
message.
10



ICDM-RX/TCP (DeviceMaster) and ICRPC (RocketPort EXPRESS) 
Windows Driver Installation
20
24

-0
2

8. Click Launch PortVision DX and Finish in the last 
installation screen.

9. Click Yes to the Do you want to allow this app to make 
changes to your device? message.

10. Click Scan so that PortVision DX locates the DeviceMaster.
PortVision DX displays the the following Ethernet attached 
productss for which you chose to scan. See the PortVision DX 
help system detailed information about how to use it to tailor 
your view. 

11. Go to the next discussion to program the network information 
into the DeviceMaster.
11
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2.4. Program the IPv4 Address (Network Information)

If you have not done so, program the IPv4 address for your network. The following procedure is to program a 
single DeviceMaster, if you want to program IPv4 addresses into multiple DeviceMasters, refer to the 
PortVision DX help system or the ICDM-RX/TCP Installation and Configuration Manual.
Default Network Settings
• IPv4 address: 192.168.250.250
• IPv4 Subnet mask: 255.255.0.0
• IPv4 Gateway address: 192.168.250.1
1. If necessary, start PortVision DX, Start > Pepperl+Fuchs > PortVision DX.
2. If the DeviceMaster that you want to program is not displayed, click Scan.
3. Right-click the DeviceMaster in the Device Tree or Device List pane for which you want to program network 

information and click Properties.
Note: Optionally, you can double-click the DeviceMaster and PortVision DX opens the Properties page.
12

https://www.pepperl-fuchs.com


ICDM-RX/TCP (DeviceMaster) and ICRPC (RocketPort EXPRESS) 
Windows Driver Installation
20
24

-0
2

4. Optionally, enter a friendly device name in the Device Name list box. The default name is Device and the 
last three pairs of digits from the MAC address.

5. Optionally, enter the DeviceMaster serial number in the event you need to contact Pepperl+Fuchs.
Note: The device status from the main screen displays in the Device Status list box.

6. Select the appropriate Detection Type for this DeviceMaster.
• REMOTE means that IP communications are used instead of MAC communications. This is generally 

an indication the DeviceMaster is not on the local Ethernet segment
• LOCAL means that the MAC communications level is used and the DeviceMaster must be on the local 

segment for MAC mode to be used. An IP address is not required but Technical support recommends 
using an IP address.

7. Select the appropriate IP Mode for your installation:
• If you want to disable IP communications on the DeviceMaster, click Disable IP. 
• To use the DeviceMaster with DHCP, click DHCP IP, and make sure that you provide the MAC address 

of the device to the network administrator. Make sure that the administrator reserves the IP address, 
subnet mask and gateway address of the DeviceMaster in the DHCP server. 

• To program a static IP address, click Static IP and enter the appropriate values for your site. 
8. Leave the Bootloader Timeout set to the default 15.
9. Click Apply Changes and Close.
10. Go to Check the SocketServer Version on Page 15 to verify that you have the latest SocketServer version.
13
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2.5. Program the IPv6 Address (Network Information)

You must use DeviceMaster web page to program an IPv6 address. You can refer to www.ipv6.com for 
information about IPv6.
Default Network Settings
• IPv4 address: 192.168.250.250
• IPv4 Subnet mask: 255.255.0.0
• IPv4 Gateway address: 192.168.250.1
You may want to use PortVision DX to program an IPv4 address so that you can open the DeviceMaster web 
page without changing your system IP settings to communicate with DeviceMaster.
Use the following procedure to program an IPv6 address. 
1. Open your browser and enter the DeviceMaster’s IP address.
2. Click the Network tab.
3. Optionally, configure a Host Name or change any of the General options.
4. Under IPv6, either select Use DHCPv6 or User static config below option.
5. If you selected a static address, enter the IPv6 address, Prefix Length, and if necessary, the Gateway.
6. Click the Save button.

Note: You must reboot for changes on this page to take affect.
7. Click the System tab and then click the Reboot option.
8. Optionally, click the Reboot Now button or let the web page reboot using the timer. 
9. Go to Check the SocketServer Version on Page 15 to verify that you have the latest SocketServer version.
14
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2.6. Check the SocketServer Version

Check the SocketServer version installed on the DeviceMaster against the latest SocketServer version 
available through Technical Support.
1. If necessary, start PortVision DX: Start > Pepperl+Fuchs > PortVision DX.

Note: The SocketServer version displays for the DeviceMaster under the Software Version column..

2. If desired, check with Technical Support for the latest SocketServer version.
3. If necessary, use the next subsection to upload SocketServer. If you do not need to upload the latest 

version of SocketServer, you are ready to install the device NS-Link device driver using Device Driver 
Installation on Page 17.
15

https://www.pepperl-fuchs.com


ICDM-RX/TCP (DeviceMaster) and ICRPC (RocketPort EXPRESS) 
Windows Driver Installation
20
24

-0
2

2.7. Uploading SocketServer

The NS-Link device driver loads the current firmware but not until the DeviceMaster has shown that an old 
version of the SocketServer (older than 8.00) or any firmware other than NS-Link Updater is running. The driver 
does not upload anything unless it first connects to the default application (SocketServer) on the DeviceMaster. 
Optionally, you can upload the appropriate version of SocketServer after running the NS-Link device driver 
Installation Setup Wizard.
Use the following procedure to upload the latest SocketServer version using PortVision DX.
1. Start PortVision DX, click: Start > Pepperl+Fuchs > PortVision DX.
2. Right-click the DeviceMaster or DeviceMasters of which you want to upload the latest version of 

SocketServer and then click Advanced > Upload Firmware.

3. Browse to the location where you downloaded SocketServer, highlight the file, and click Open.
4. Click Yes to the Upload Firmware popup.
5. Click Yes to the second Upload Firmware popup.

You can click Refresh to verify that the upload has been 
successfully completed.

If the upload fails, use the PortVision DX General tab on the 
Properties screen to change the Bootloader Timeout to 45 
seconds and then repeat Steps 2 through 5. 
16
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3.  Device Driver Installation

This section discusses the following topics:
• Installation Setup Wizard on Page 18 for initial installation procedures
• Checking the Device Driver Version on Page 23
• Updating the Device Driver on Page 23
• Adding to an Existing Installation on Page 27

3.1. Installation Overview

Windows Driver Management Console specific installation instructions for the DeviceMaster and RocketPort 
are discussed below.

3.1.1. DeviceMaster
If there is an NS-Link device driver already installed on your system for the DeviceMaster, use the following 
discussions:
• Updating the Device Driver on Page 23 if you want to update the existing driver.
• Adding to an Existing Installation on Page 27 to add more DeviceMasters to the existing installation.
If you have performed the following procedures, you can skip to Installation Setup Wizard to start NS-Link 
device driver installation. 
You can use Before Installing the DeviceMaster Driver on Page 8 for procedures for these steps.
1. Install the DeviceMaster. 
2. Install PortVision DX.
3. Program the network information (IP address) using PortVision DX.
4. Upload the appropriate version of SocketServer firmware.

3.1.2. RocketPort
If there is a device driver already installed on your system for the RocketPort, see Updating the Device Driver on 
Page 23 or Adding to an Existing Installation on Page 27.
17
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3.2. Installation Setup Wizard

You can use the following procedure to install the device driver for DeviceMaster or RocketPort, which is used to 
configure the driver.
Note: Most installation steps are the same for the DeviceMaster and RocketPort. Some procedures are 

specific to the products and are identified accordingly.
1. Download the appropriate device driver from https://www.pepperl-fuchs.com for your product and copy it to 

a location that is available to the host.
Note: Administrative privileges are required to install device drivers on Windows operating systems.

2. Close any applications that are using serial ports before the device driver installation.
3. RocketPort: 

a. Install the adapter and connect the interface (Quadcable, Octacable, or breakout box). If you need 
hardware installation procedures. You can download the ICRPC and ICRPB (RocketPort EXPRESS) 
Hardware Installation Manual. 

Do not connect RS-422/485 devices until the appropriate port interface type has been 
configured in the device driver. 

b. Click Cancel if a Found New Hardware message appears.
4. Start the installation by executing the .exe file for your device.
5. If necessary, click the Yes button to the Do you want to allow this app to make changes to your device 

message.

Caution
18
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6. Click Next to start the installation.

7. Optionally, enter a different location to install the driver files.

8. Click Install.
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9. Leave the Launch option checked and click Finish.

Note: Additionally, a shortcut is available under Pepperl+Fuchs in the Start menu.
10. Click Next to install the driver.

11. Click Install and Next.
20
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12. DeviceMaster:
a.  Select the model that you want to install and enter the number of this DeviceMaster model that you 

want to install and click Ok.

b. Click Next.

c. Repeat Step 12 for each DeviceMaster that you want to install and click Next.
13. RocketPort: click Next.
21
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14. Click Proceed.

15. Click the Launch DeviceMaster or RocketPort button.

Note: You can close the Driver Installation Wizard after launching the Windows Driver Management 
Console.

16. DeviceMaster:
a. Go to Device Driver Configuration on Page 28 to start NS-Link device driver configuration. 
b. The device driver installation is not complete until you have configured the DeviceMaster using 

procedures discussed in DeviceMaster Associating the MAC Address on Page 36. 
c. After associating the MAC address, go to Configuring Device Settings on Page 43 to set up device 

properties (device name and starting COM port number).
d. Go to Configuring COM Port Properties on Page 47 to configure any necessary COM port 

characteristics.
After driver installation and configuration, connect the serial devices to the ports. For information about the 
DeviceMaster connectors, refer to the ICDM-RX/TCP Installation and Configuration Manual

17. RocketPort:
a. Go to Configuring COM Port Properties on Page 47 to configure the COM port properties for 

RocketPort adapters
b. If desired, go to Configuring Device Settings on Page 43 to set up advanced device properties (device 

name and starting COM port number).
22
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After driver installation and configuration, connect the serial devices to the ports. For information about the 
RocketPort connectors, refer to the ICRPC and ICRPB (RocketPort EXPRESS) Hardware Installation 
Manual.

3.3. Checking the Device Driver Version

You can check the driver version using the following procedure.
1. In the Windows Driver Management Console for your product, right-click your product and click 

Properties.
2. If necessary, click the Driver tab to view the device driver version.

Note: Please note that Microsoft truncates leading zeros in the versions number. 
If necessary, you can update the device driver using the next subsection.

3.4. Updating the Device Driver

Use the following procedure to update the device driver after initial installation.
If you are unsure what driver version is running, see Checking the Device Driver Version on Page 23.
1. Locate the latest driver assembly and copy it to a location that is available to the host.
2. Close any applications that are using serial ports before the device driver installation.
3. Start the update by executing the .exe file.
4. Click the Yes button to the Do you want to allow this app to make changes to your device message.
23
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5. Click Next to start the Installation Setup Wizard.

6. Optionally, enter a different location to install the latest device driver files.

7. Click Install.
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8. Leave the Launch DeviceMaster or RocketPort Driver Installation box checked and click Finish.

If you do not check this box, you can use the shortcut under the Start button at: Pepperl+Fuchs > Product 
Driver Installation Wizard. 

9. Click Next to update the driver.

10. Click Update and Next.
25
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11. Click Next to update the driver.

12. Click Proceed.

Note: This may take several minutes depending upon the number of ports involved in the update.
13. RocketPort: click Reboot My Computer for the update to complete.
26
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14. Click the Launch Windows Driver Management Console button to configure the ports or device 
properties.

15. Return to the Installation wizard and click Close.
16. If necessary, go to Configuring COM Port Properties on Page 47 to configure the COM port properties.
17. If desired, go to Configuring Device Settings on Page 43 to set up advanced device properties (device 

name and starting COM port number).

3.5. Adding to an Existing Installation

Use the following procedure to add a DeviceMaster or RocketPort to an existing installation.
1. Close any applications that are using serial ports before the device driver installation.
2. RocketPort: Install the adapter and connect the interface (Quadcable, Octacable, or interface box).

DeviceMaster: Connect the DeviceMaster to your network and use PortVision DX to program the IP 
address.
If you need hardware installation procedures, see https://www.pepperl-fuchs.com. 

Do not connect RS-422/485 devices until the appropriate port interface type has 
been configured in the device driver. The default port setting is RS-232.

3. RocketPort: Click Cancel if a Found New Hardware message appears.
4. From the Start button, click Pepperl+Fuchs> Product Driver Installation Wizard.: 
5. Click the Yes button to the Do you want to allow this app to make changes to your device message.
6. Click Next to start the Windows Driver Management Console.
7. Click Install and Next.
8. Click Next and follow the Installation Wizard for the remainder of the installation steps if needed. 

• RocketPort: Refer to Step 11 on Page 20
• DeviceMaster: Refer to Step 12 on Page 21, 

Caution
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4.  Device Driver Configuration

4.1.  Overview

This chapter discusses driver configuration for the Windows Driver Management Console.

4.1.1. DeviceMaster
If you programmed an IPv4 address into the DeviceMaster for your network using PortVision DX before 
installing the NS-Link device driver; first associate the MAC address to the DeviceMaster and then configure 
the driver with the IPv4 address that you programming into the DeviceMaster using PortVision DX.
DeviceMaster Driver Configuration Overview on Page 28 provides configuration procedures.

4.1.2. RocketPort
The RocketPort driver configuration discussions are available.
• Using the Windows Driver Management Console on Page 30
• Configuring Device Settings on Page 43
• Configuring COM Port Properties on Page 47

4.2. DeviceMaster Driver Configuration Overview

This subsection provides information for the DeviceMaster driver configuration.
• NS-Link Device Driver Configuration Considerations
• Using the Windows Driver Management Console on Page 30
• DeviceMaster Associating the MAC Address on Page 36
• Using the Driver in IPv4 Mode on Page 39
• Using the Driver in IPv6 Mode on Page 40
• Enabling SSL on Page 41
• Configuring Device Settings on Page 43
• Configuring COM Port Properties on Page 47
• DeviceMaster Network Configuration on Page 52

- Disabling IPv4 Mode on Page 52
- Changing a Static IPv4 Address on Page 53
- Setting Up DHCP (IPv4) on Page 54

• Configuring DeviceMaster Ports as Sockets on Page 56
• Enabling Secure Data Mode on Page 58
28
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4.2.1. NS-Link Device Driver Configuration Considerations
The following subsections discuss the NS-Link device driver features and topics that you may want to review 
before driver configuration.

4.2.2. IP or MAC Addressing Issues
This is an overview of IP and MAC addressing issues that may affect how you configure the DeviceMaster with 
a brief discussion of advantages of each method.
Note: The default IPv4 address for the DeviceMaster is 192.168.250.250.
The IPv4 and IPv6 addressing scheme (IP mode) has the following advantages:
• Uses an IEEE industry standard protocol.
• Allows you to configure systems to use ports on the DeviceMaster that are outside of the host system’s local 

Ethernet segment.
Note: This IP address must be a unique reserved IP address. Do not use an address from a dynamic address 

pool. If necessary, see the system administrator for an IP address.
The MAC addressing method (MAC mode) has the following advantages:
• Simplifies implementation and ongoing support by eliminating the address administration issues inherent in 

network protocols. MAC addresses are predefined by DeviceMaster and there is no potential for an 
address conflict at setup. 

• It is isolated from foreign LAN segments minimizing potential security issues.
• Maximizes throughput of serial data.

4.2.3. NS-Link Device Driver Features
During initial installation and configuration of the NS-Link device driver, Pepperl+Fuchs recommends that you 
associate the MAC address to the DeviceMaster. If you do not do so, you will not be able to use the following 
device driver features:
• Access the Advanced tab to review PC network or device network interface statistics
• Program or change an IP address using through the Network Settings button
• Reboot the DeviceMaster from the Windows Driver Management Console
After associating the MAC address, you can then program the DeviceMaster for IP or DHCP usage.
You can refer to IP or MAC Addressing Issues on Page 29 for information about MAC addressing and IP 
addressing issues.
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4.2.4. Using the Port Sharing Feature
DeviceMaster ports can be shared by installing the NS-Link device driver on multiple systems or through socket 
mode, or combination of both. To do so, install the NS-Link driver on each system that you want to permit 
access to the serial ports. You can share the same port with multiple systems (only one system can have an 
open connection to a port at any given time) or you can set up multiple systems to share specific ports on the 
device driver..

Use port sharing to configure redundant PCs or fail-over protection.

Note: Most applications do not release ports, so you may not be able to use port sharing across multiple 
systems with the same port. Also, if using port sharing, make sure that two computers do not try to 
access the same port at the same time. Only one computer can control a given port at a given time.

4.3. Using the Windows Driver Management Console

This subsection discusses basic Windows Driver Management Console operations, such as:
• Accessing the Windows Driver Management Console
• Displaying All Installed Devices on Page 31
• How to Configure Device Properties on Page 32
• Customizing the Device Name on Page 33
• Customizing the COM Port Name on Page 34
• How to Configure COM Port Properties on Page 35
• How to Save Changes on Page 35
DeviceMaster: See DeviceMaster Associating the MAC Address on Page 36 to start DeviceMaster 
configuration procedures.
RocketPort: See Configuring Device Settings on Page 43 to start configuration procedures for your adapter.

Port System A System B
1 COM5 Not Configured
2 COM6 Not Configured
3 Not Configured COM5
4 Not Configured COM6

DeviceMasterPort 1 

System A System B

Port 2
COM 5 COM 6

Port 3 Port 4
COM 5 COM 6

Ethernet Hub

Configured for System A Configured for System B 

Example:
To configure two ports for System A and two ports for System B, 
1. When installing the device driver on System A, click “Not Configured” for the 

2. When installing the device driver on System B, click “Not Configured” for the 

Multiple systems can use the same COM port names.

:

you could configure the drivers like this:
    COM port names for Ports 3 and 4.

    COM port names for Ports 1 and 2.
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4.3.1. Accessing the Windows Driver Management Console
Access the Windows Driver Management Console located under Start > Pepperl+Fuchs > Product> 
Windows Driver Management Console.

4.3.2. Displaying All Installed Devices
The Windows Driver Management Console opens and displays all products for which a device driver was 
installed. 

To collapse the view, click - in the Tree View pane to close the selected family. To view a family or device, click 
the + to open the selected family. 
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4.3.3. How to Configure Device Properties
This overview discusses changing device properties for a product. Highlight the device name of the product 
that you want to configure in the Tree View pane. Make any necessary changes.
• Click Apply to save the changes, which saves the changes and leaves the Windows Driver Management 

Console open.
• Click Ok to save the changes and close the Windows Driver Management Console.
• Click Cancel to close the Windows Driver Management Console without saving the changes.
If you click a port or device name without saving the changes, the Windows Driver Management Console 
prompts you to Apply, Ignore, or Cancel the changes.
For more information, see Configuring Device Settings on Page 43.
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4.3.4.  Customizing the Device Name
Change the default Device Name on the Device General tab by changing the name in the User-Friendly 
Device Name field and saving the change.

Note: The Device Name will display the next time you open the Windows Driver Management Console.
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4.3.5. Customizing the COM Port Name
Change the default Port Name on the Port Settings General tab by changing the name in the User-Friendly 
Port Name field and saving the change.
Note: This displays a DeviceMaster, the RocketPort Port pages are the same.
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4.3.6. How to Configure COM Port Properties
To change a port’s properties for a product, 
highlight the port of the product that you want to 
configure in the Tree View pane. Make any 
necessary changes:
• Click Apply to save the changes, which 

saves the changes and leaves the Windows 
Driver Management Console open.

• Click Ok to save the changes and close the 
Windows Driver Management Console.

• Click Cancel to undo the changes and 
close the Windows Driver Management 
Console.

If you click another port or device name without 
saving the changes, the Windows Driver 
Management Console will prompt you to Apply, 
Ignore, or Cancel the changes.
For more information, see Configuring COM 
Port Properties on Page 47.
After saving the port changes, if desired, you can click Apply These Settings to All Ports to populate the 
remaining ports with these COM properties.

Note:  Not all products support the Terminate Resistor Options feature.

4.3.7. How to Save Changes
The Windows Driver Management Console indicates that changes have been made on this screen with a red 
frame that identifies which device’s General tab you are editing.
• Clicking the Apply button saves the changes on the tab and leaves the Windows Driver Management 

Console open for further configuration.
• Clicking the Ok button saves the changes on that tab and closes the Windows Driver Management 

Console.
• Clicking the Cancel button cancels the 

changes on that tab and closes the 
Windows Driver Management Console. 
Note: The red frame around Port 

indicates that the change has not 
been saved.
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4.4. DeviceMaster Driver Configuration

4.4.1. DeviceMaster Associating the MAC Address
The first step to configuring the NS-Link device driver is to associate the MAC address of the DeviceMaster to 
the device driver.
You can use the method that is appropriate to your installation:
• Same Network Segment (below)
• Different Physical Segment on Page 38
Although you can and should associate a MAC address on a different physical segment, the DeviceMaster 
must be connected to the local network segment or directly to a NIC on the host system for the NS-Link driver to 
operate in MAC Mode. 

4.4.2. Same Network Segment
The DeviceMaster must be connected to the local network segment or directly to a NIC on the host system to 
operate in MAC mode and in order for PortVision DX to detect the MAC address, otherwise you must enter the 
MAC address manually.
Use the following procedure to associate a MAC address to a DeviceMaster.
1. If necessary, access the Windows Driver Management Console, click Start > Pepperl+Fuchs > Windows 

Driver Management Console.
2. Highlight the Device Name of the DeviceMaster that you want to configure.
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3. Select the MAC address from the drop-down list or enter the address from the MAC address label on the 
DeviceMaster.
If the appropriate MAC address is not displayed in the drop-down list, then it can be one of the following 
reasons:
• The DeviceMaster is not on the same network segment
• The DeviceMaster not powered on or connected to the network
• The DeviceMaster wrong model was selected during the driver installation
• Device failure
Note: If you enter the MAC address, make sure that you use the correct format: 00 0D 81 or 00 C0 4E xx 

xx xx. A space must separate each pair of digits. The MAC address is located on a label on the 
DeviceMaster.

If you programmed the IPv4 address using PortVision DX, the IPv4 address displays in the IPv4 Mode text 
box.

4. Click Apply to program the driver with the MAC address of the DeviceMaster.
If you do not Apply the changes before leaving this screen, you will be prompted to Apply, Ignore, or 
Cancel the changes.

5. Optionally, you can click the Advanced tab and verify that the Device Status message indicates that the 
DeviceMaster is active and Ok.

6. You may need to perform some of the following tasks to complete the driver configuration process.
• Configure the DeviceMaster for IP Mode, see the appropriate discussion:

- Using the Driver in IPv4 Mode on Page 39
- Using the Driver in IPv6 Mode on Page 40

• Enable SSL, see Enabling SSL on Page 41
• Configure device properties, see Configuring Device Settings on Page 43.
• Configure COM port properties, see Configuring COM Port Properties on Page 47.
• Configure any of the DeviceMaster ports as sockets, see Configuring DeviceMaster Ports as Sockets 

on Page 56.
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4.4.3. Different Physical Segment
Use the following procedure to associate a MAC address to a DeviceMaster that is not on the same physical 
network segment or not connected directly to the NIC.
1. If necessary, start the Windows Driver Management Console.
2. Highlight the Device Name of the DeviceMaster that you want to configure.
3. Enter the MAC address in the MAC Mode text box.

Note: When you enter the MAC address, make sure that you use the correct format: 00 0D 81 or 00 C0 4E 
xx xx xx. A space must separate each pair of digits. A MAC address is located on a label on the 
DeviceMaster or use PortVision DX to scan the network, which will display the MAC address.

4. Click Apply to program the driver with the MAC address of the DeviceMaster or Ok to save the change and 
close the Windows Driver Management Console.
If you do not Apply the changes, you will be prompted to Apply, Ignore, or Cancel the changes.

5. You may need to perform some of the following tasks to complete the driver configuration process.
• Configure the DeviceMaster to operate in IPv4 Mode using the next subsection.
• Configure the DeviceMaster to operate in IPv6 mode using Using the Driver in IPv6 Mode on Page 40.
• Configure a DHCP addressing, refer to DeviceMaster Network Configuration on Page 52
• Configure device properties, see Configuring Device Settings on Page 43.
• Configure COM port properties, see Configuring COM Port Properties on Page 47.
• Configure any of the DeviceMaster ports as sockets, see Configuring DeviceMaster Ports as Sockets 

on Page 56.
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4.4.4. Using the Driver in IPv4 Mode
After associating the DeviceMaster with the MAC address you can set the DeviceMaster to run in IPv4 Mode. 
1. First associate a MAC address (Page 36) to the DeviceMaster.
2. Highlight the DeviceMaster.
3. If the DeviceMaster is not on the same network segment, enter the IP address of the DeviceMaster in the IP 

Mode text box.
If the DeviceMaster is on the same network segment, the driver populates the IP Mode text box with the 
DeviceMaster IP address.

4. Click the IPv4 Mode radio button.

5. If you do not have any other configuration changes, click Apply. If you have other configuration changes, 
refer to the appropriate subsection:
• Enabling SSL on Page 41
• Configuring Device Settings on Page 43
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4.4.5. Using the Driver in IPv6 Mode
After associating the DeviceMaster with the MAC address you can configure the DeviceMaster to run in IPv6 
Mode. 
Note: You must first program the IPv6 address in the DeviceMaster. Refer to Program the IPv6 Address 

(Network Information) on Page 14 for IPv6 programming procedures.
You can refer to www.ipv6.com for information about IPv6.
1. First associate a MAC address (Page 36) to the DeviceMaster.
2. Highlight the DeviceMaster.
3. Click the IPv6 Mode radio button.
4. Enter the IPv6 address and the subnet mask prefix length.

• After driver installation, the Windows Driver Management Console may display the link-local address 
for the DeviceMaster in the IPv6 Mode field. 
You can identify the link-local address by the prefix: FE80. The link-local address is a network address 
that is valid only for communications within the network segment or the broadcast domain to which the 
host is connected. Link-local addresses are usually not guaranteed to be unique beyond a single 
network segment. Routers do not forward packets with link-local addresses.

• The subnet mask prefix length is 1 - 128. The smallest recommended subnet is 64, an entry is required.

5. If you do not have any other configuration changes, click Apply. If you have other configuration changes, 
refer to the appropriate subsection:
• Enabling SSL on Page 41
• Configuring Device Settings on Page 43
40
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4.4.6. Enabling SSL
After associating the DeviceMaster with the MAC address and configuring it to run in IP Mode, you can 
configure SSL Mode. 
Note: After configuring SSL Mode in the driver, remember that you will need to configure SSL Mode in the 

web interface (Enabling Secure Data Mode on Page 58).
1. Click Enable SSL Mode or go to Step 4.

The DeviceMaster must be configured using IP Mode before you can Enable SSL Mode. If SSL Mode is 
enabled, TCP connections that carry data to/from the serial ports are encrypted using SSL or TLS security 
protocols. This includes the following:
• TCP connections to the per-serial-port TCP ports (default is 8000, 8001, 8002, ...) are encrypted using 

SSL/TLS.
• TCP connections to TCP port 4606 on which the DeviceMaster implements the Pepperl+Fuchs 

proprietary serial driver protocol are encrypted using SSL/TLS.
• Since SSL/TLS can not be used for either UDP data streams or for the Pepperl+Fuchs proprietary MAC 

mode Ethernet driver protocol, both UDP and MAC mode serial data transport features are disabled.
In addition to encrypting the data streams, it is possible to configure the DeviceMaster so that only 
authorized client applications can connect using SSL/TLS.
For this option to function, you must also Enable Secure Data Mode in the NS-Link web page. 
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2. If you are using a server certificate, click the Server Certificate check box and enter the name in the 
Server Certificate text box.

This is the RSA identity certificate that the DeviceMaster uses during SSL/TLS handshaking to identify 
itself. It is used most frequently by SSL server code in the DeviceMaster when clients open connections to 
the DeviceMaster's secure web server or other secure TCP ports.
If a DeviceMaster serial port configuration is set up to open (as a client) a TCP connection to another server 
device, the DeviceMaster also uses this certificate to identify itself as an SSL client, if requested by the 
server.

3. If you are using a client certificate, click the drop list and browse to the appropriate client certificate file.
When configured with a CA certificate, the DeviceMaster requires all SSL/TLS clients to present an RSA 
identity certificate that has been signed by the configured CA certificate. As shipped, the DeviceMaster is 
not configured with a CA certificate and all SSL/TLS clients are allowed.
If desired, controlled access to SSL/TLS protected features can be configured by uploading a client 
authentication certificate to the DeviceMaster.
When a CA certificate is uploaded, the DeviceMaster only allows SSL/TLS connections from client 
applications that provide to the DeviceMaster an identity certificate that has been signed by the CA 
certificate that was uploaded to the DeviceMaster.
This uploaded CA certificate that is used to validate a client's identity is sometimes referred to as a trusted 
root certificate, a trusted authority certificate, or a trusted CA certificate. This CA certificate might be that of 
a trusted commercial certificate authority or it may be a privately generated certificate that an organization 
creates internally to provide a mechanism to control access to resources that are protected by the SSL/TLS 
protocols.
To control access to the DeviceMaster's SSL/TLS protected resources you should create your own custom 
CA certificate and then configure authorized client applications with identity certificates signed by the 
custom CA certificate.

4. Click Apply or Ok to save the change and close the Windows Driver Management Console.
5. You may need to perform some of the following tasks to complete the configuration process.

• Configure device properties, see Configuring Device Settings on Page 43.
• Configure COM port properties, see Configuring COM Port Properties on Page 47.
42



ICDM-RX/TCP (DeviceMaster) and ICRPC (RocketPort EXPRESS) 
Windows Driver Installation
20
24

-0
2

• Configure any of the DeviceMaster ports as sockets, see Configuring DeviceMaster Ports as Sockets 
on Page 56.

• Enable Secure Data Mode in the NS-Link web page, see Enabling Secure Data Mode on Page 58.

4.5. Configuring Device Settings

Use the following procedure to change device settings using the Windows Driver Management Console
1. Open Windows Driver Management Console.
2. Highlight the DeviceMaster or RocketPort device name that you want to configure.

3. If desired, change the User-Friendly Device Name.
4. RocketPort: 

a. If desired, set a Starting COM Port number value.
b. Select the Driver’s Working Mode.
c. Optionally, select a different Scan Rate (ms) (Page 44).
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5. DeviceMaster:
a. Optionally, set a different Keep Alive Timeout (Page 45) period. You can set the amount of time in 

seconds that this DeviceMaster waits until it closes this connection and frees all the ports associated 
with it.
Note: This value may be set to less than 5 seconds, however the DeviceMaster may not operate at 

any value less than 5. A recommended value to begin experimentation with is 10.
b. Optionally, set the TCP Timeout Multiplier (Page 46) value.

Note: This value should not be modified unless the network connection to the DeviceMaster is very 
slow, such as, if a satellite uplink connection is involved. It is recommended that a value over 3 
never be used. Setting to 0 will inhibit the DeviceMaster from fully booting and will remain at a 
Redboot prompt.

c. Optionally, click a different Scan Rate (ms) (Page 44).
6. Optionally, click Verbose Event Log if you want to log additional device information into the event log.
7. After making your changes, click Apply if you have additional configuration procedures or click Ok if you 

have completed configuring your Pepperl+Fuchs devices.
Note: If you do not Apply the changes, you will be prompted to Apply, Ignore, or Cancel the changes.

The following table provides detailed information about Device General tab options for the Windows Driver 
Management Console.

Device General Tab Descriptions 
Common Options (DeviceMaster and RocketPort

Device Name
This is the default name assigned by the driver and it cannot be 
changed. You can use the User-Friendly Device Name field to provide 
custom device names for your installation.

User-Friendly Device 
Name

Use this field to enter a more descriptive name. The name that you 
assign is not saved until you click Apply or OK.

Verbose Event Log
Default = Disabled

Selecting this option causes detailed messages to be sent to the 
operating system Event Log. This added information can be useful when 
debugging communications and configuration problems

Scan Rate (ms)]
Default = 10ms

Typically, you should leave the scan rate set to the default value (10 ms) 
for most applications. To adjust latency for time-critical applications, 
select a longer or shorter interval from the droplist, or type in the rate (2 
to 50). If a value larger than 50 is entered, the maximum of 50 is 
implemented. 
Note: The faster the scan rate (lower number), the higher the load on 

the system processor.

Save Configuration
Click Save Configuration to save the Device Settings for use on another 
similar Pepperl+Fuchs device or to archive a copy of your environments 
settings.

Load Configuration

Click to Load Configuration to load the Device Settings previously saved 
using the Save Configuration feature.

• DeviceMaster: Configuration files must be for the same model 
with the same port density. For example, you cannot load a 
configuration file onto a DeviceMaster or a configuration file for a 
32-port DeviceMaster onto a 4-port  DeviceMaster.

• RocketPort:You cannot a load configuration file from different 
models. For example, you cannot load a configuration file for a 
RocketPort INFINITY on a RocketPort.

Ok Click Ok to save the changes made on this page and close the Windows 
Driver Management Console.

Cancel Cancels any changes made on this page.
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Apply
Click Apply to save the settings on this page. If you do not click Apply 
before leaving this page, you will be prompted to Apply or Cancel the 
changes.

DeviceMaster Device Options

DeviceMaster
Keep Alive Timeout 
(seconds) 
Default = 120 seconds

Use this option to set the amount of time in seconds that this 
DeviceMaster waits until it closed this connection and frees all the ports 
associated with it. The Keep Alive feature works in the following way.
During normal operation the driver periodically sends a connection 
check to the DeviceMaster, and the DeviceMaster then returns a 
response. There are two timers: one in the driver, and one in the 
DeviceMaster. These timers are reset when a connection check signal is 
received. If a connection is broken, that is, a check is not received, the 
data is stored in the computer and/or the DeviceMaster. Depending on 
the amount of time that has expired since the connection was lost, the 
following happens:
• When the computer loses its connection to the DeviceMaster but re-

establishes it before the time-out period expires, any data 
transmitted during this period is queued and sent when the 
connection resumes. 

• When the computer loses its connection to the DeviceMaster and 
does not re-establish it before the time-out period expires; the driver 
then purges any pending I/O data for ports on that connection and 
returns all pending, and future I/O commands, with the exception of 
the Close command, to the application with an error indicating the 
disconnected status. 
This is similar to the processing which occurs when the computer 
receives a notification from the DeviceMaster that a port release 
request was processed on a port it owns with the exception that a 
different status is returned. When the connection is re-established, 
the computer will attempt to re-acquire the ports that were open 
when the connection was lost. If the attempt is successful, normal 
operations resume for the port. If any port fails to be acquired, then 
the computer will continue to fail all further I/O operations, with the 
exception of a Close request. When the Close request is received, 
the port can then be re-opened.

• If the computer loses its connection and the time period expires, the 
DeviceMaster places the port into a state that another computer can 
establish a connection, locking out the original driver when a 
connection is made. The driver will respond to all I/O commands, 
with the exception of the Close command, with an error indicating 
the disconnected status. If the port is still available when the driver 
re-establishes a connection, then it will claim the port and allow I/O 
to resume.

Device General Tab Descriptions (Continued)
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DeviceMaster
TCP Timeout Multiplier
Default = 1ms

Use the TCP Timeout Multiplier option to modify two timers used in 
TCP/IP socket communications. 
The first identifies how long the TCP protocol should wait before timing 
out an attempt to open a TCP channel. The TCP Timeout Multiplier 
default is 1 and the timer defaults to 500 ms when the TCP/IP address 
method is used to communicate with a device. 
If the TCP Timeout Multiplier is set to 2, the timer would now be 1000 
ms, or 1 sec. If the multiplier is 4, the new time-out period would be 2000 
ms, or 2 sec.
The second timer defines how long the driver will wait for a response 
from the DeviceMaster when a forced release of a port is requested. 
This timer defaults to 8 seconds. 
If the TCP Timeout Multiplier is changed to 2, the timer would now be 
16 seconds. If the multiplier is 4, the new time-out period would be 32 
seconds.

Defaults Resets this screen to its default values.
RocketPort Device Options

RocketPort
Starting COM Port Number

You can change the starting COM port number in the drop list for this 
adapter.
In addition, you can use Starting COM Port to set nonsequential 
starting COM port numbers for each adapter, thus leaving gaps in the 
COM port numbering sequence.
When you change the starting COM port number, the driver assigns that 
COM port to the first port on this adapter and all other port numbers 
follow in sequence.
Do not overlap COM port numbers between devices or other adapters 
because if you do so, the overlapping ports are disabled.

RocketPort
Driver’s Working Mode

Select the mode that meets your application requirements.
Polling (default)
• Smaller packets
• Lower volume
• Faster I/O (Low Latency)
• Predictability (Based on Scan rate)
• Perfect for low baud rates or low volume transfer where the 

operation is time critical.
Interrupts
• Larger packets
• Higher volume
• The speed of I/O depends on the volume of data 
• Unpredictable
• Perfect for high baud rate, high volume data transfer.

Device General Tab Descriptions (Continued)
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4.6. Configuring COM Port Properties

This section discusses COM port configuration procedures for Windows Driver Management Consoleports. If 
you want to change the starting COM port number on the device, see Configuring Device Settings on Page 43.
If your application does not set COM port properties, use the Device Manager to access Ports (COM & LPT) to 
change the port parameters. If the application sets COM port properties, those settings take precedence over 
Windows COM port settings. The exception to this guideline is if you use the Override and Lock Baud Rate to 
option.
Use the following procedure to change COM port settings on the device port or ports.

Do not connect RS-422/485 devices until the appropriate port interface type 
has been configured in the driver. The driver default port setting is RS-232.

1. Open the Windows Driver Management Console (Page 31).
2. Highlight the appropriate device.
3. Highlight the first port you want to configure.
4. Select the appropriate communications mode.

Note: The COM port configuration page for DeviceMaster and RocketPort provide the most of the same 
options.

Caution
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5. DeviceMaster: If your model supports Terminator Resistor Options, and you select RS-422 or RS-485, you 
may want to configure Terminator Resistor options. If so, click the Terminator Resistor Options button.
a. Make the appropriate selections to reflect your configuration. 
b. Click Ok.

6. Enable the features that you require for your environment.
Note: You can use the help system or refer to the following table for information about each option.

7. RocketPort: Select the Use Fast (Low Latency) Data Transfer option when receiving or sending small 
blocks of data.

8. Optionally, click the RTS Toggle Options button:
• If your communications application does not toggle FTS when transmitting in RS-485 mode.
• If you are using an external RS-232 to RS-

485 converter, which is attached to a port that 
is configured for RS-232. 

a. Click the appropriate options for your 
environment.

b. Click OK to save the changes and return to 
the port General tab.

9. If desired, click the Clone check box to set all of 
the ports on this device to these characteristics.

10. Optionally, change the User-Friendly Port 
Name.

11. If desired, select a different COM Name (COM 
port number). The drop-down list displays (in 
use) next to COM port numbers that are already in use in this system. Do not duplicate COM port numbers 
as this will cause the ports to not function.

12. Click Apply to save these changes.
Note: If you selected RS-422 mode, make sure that there is not a device attached to the port and click Ok.

13. Highlight the next port that you want to configure and perform Steps 4 through 12. 
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The following table provides information about the options on the port General tab.
Port Settings General 

Tab Descriptions 

RS Mode
Default = RS-232

Use this drop-down list to select the communications mode for the serial device 
that you will be connecting to this port.
• RS-232 (default)
• RS-422
• RS-485 Mode provides these choices.

Note: The  DeviceMaster DIN rail models support RS-485 4-wire, Slave or 
Master but this feature is not supported in panel and rack mount 
models.

- RS-485 2-wire (half-duplex) supports transmit and receive data. When 
data is transmitted, the Transmit Enable signal is activated, and the 
transmit receive device switches from receive to transmit automatically.

- RS-485 4-wire Master (full-duplex master) supports transmit and 
receive data, which means both signals are always active. The device is 
enabled by the Transmit Enable signal. This mode is the same as RS-422.

- RS-485 4-wire Slave (full-duplex slave) supports transmit and receive 
data. When data is transmitted, the Transmit Enable signal is activated, 
the transmit device goes active and starts sending data. When the data is 
not being sent, the transmit device is inactive. The receive device is 
always active. If you click RS-485, you may need to change settings in the 
RTS Toggle Options screen.

Override and Lock 
Baud Rate to
Default = None

This option allows you to lock selected ports.
You can select a value from the drop-down list or enter an appropriate value from 
the following standard baud rates: 300, 600, 1200, 1800, 2400, 3600, 4800, 7200, 
9600, 14400, 19200, 38400, 57600, 115200, 230400, 460800, or 921600. 
RocketPort: The Quad/Octacable models support up to 921.6Kbps and the 8/16/
32-port models with an interface box support up to 460.8Kbps.
After locking a baud rate, no matter what baud rate is selected in a host 
application, the actual rate used is the rate specified here.

Transmit Data 
Timeout Port Close
Default = 0

This option allows you to select the length of time to wait for data to clear the 
transmit buffer after a host application has closed the port. This is typically used 
with serial devices such as printers, to give the data sufficient time to flush through 
the system.
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RTS Toggle Options

This button opens the RTS Toggle Options popup, which provides the following 
features:
• Override and Lock to RS-485 Toggle Mode 

Use the Override and Lock to RTS Toggle Mode option to lock the port in 
RTS (Request to Send) toggle mode, then set the mode (low or high) as 
desired for RS-485 mode.

• RS-485 Toggle RTS Low 
Use the RTS Toggle RTS Low option to toggle the RTS output signal low 
during data transmission, which may be needed for relay devices for RS-485.
If the option box is not checked, RTS is toggled high (asserted) during data 
transmission for RS-485 mode.

• Defaults 
Clicking the Defaults button returns all the values in the RTS Toggle Options 
popup to their default state:
- Override and Lock to RTS Toggle Mode = Disabled
- RTS Toggle RTS Low = Disabled

DeviceMaster
Terminator Resistor 
Options
(Specific Models, Only)

Optionally, click the Terminator Resistor button to enable termination resistors.
To ensure the best signal integrity on a long distance high-speed RS-422 or RS-
485 network, sometimes it is required to place a 120? termination resistor 
between each of the transmit differential pair or receive differential pair. 
Signal reflection is reduced and a reliable communication is ensured by placing 
the 120? termination resistor. The DeviceMaster provides software controllable 
120? termination resistor for each differential pair on every port in RS-422 and 
RS-485 mode. Use the Termination Resistor Options popup to place 120? 
termination resistors between the signals shown below:
• RS-422 Mode

- Between TxD+ and TxD- (Pins 5 and 7)
- Between RxD+ and RxD- (Pins 4 and 2)

• RS-485 Mode – Between TxD/RxD+ and TxD/RxD- (Pins 5 and 7) 
RocketPort
Map CD to DSR
Default = Disabled

This option is used in installations where there is no connection to the port’s DSR 
input.
Click this check box to cause the CD input to appear as DSR to the host 
application, and to perform hardware handshaking with CD rather than DSR.

Map 2 Stop Bits to 1
Default = Disabled

If your application is hard-coded to use two stop bits and you receive framing 
errors, click this check box to map 2 stop bits to 1 bit. 
Leave this check box blank to enable stop bits to pass through unchanged.

Wait on Physical 
Transmission before 
Completing Write
Default = Disabled

This option forces all write packets to wait until the transmit data has physically 
completed the transmission before returning completion to the host application. 
The default mode (check box not clicked) is to buffer the data in the transmit 
hardware buffer, and return completion as soon as the packet is in the buffer.

Emulate Modem 
Hardware RING 
Signal
Default = Disabled

Click this check box to emulate the ring indicator signal. 
If this box is checked and the port receives a RING signal (or an alternate code, as 
defined in the AT command set for the modem), it sends an RI signal to the 
communications application.

Port Settings General 
Tab Descriptions (Continued)
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(DeviceMaster 1-Port 
only)
Allow Parity Conflict 
Default = Disabled

Use this option to allow a parity conflict on a DeviceMaster 1-port. It may be 
necessary to use this option after you have determined that the cabling is correct 
and you are able to transmit data but not receive proper data.

Block PnP search for 
attached serial device
Default = Disabled

This option disables plug and play from searching for a device attached to the 
serial port.
For example, data received during device discovery on a device is assumed to be 
a mouse to plug and play.

Clone: Apply all the 
settings to all ports
Default = Disabled

If this check box is not clicked, changes apply to the selected port only. 
If this check box is clicked, changes apply to all ports on this board.

RocketPort
Use Fast (Low 
Latency) Data 
Transfer
Default = Disabled

Use this option when you need to send or receive a small block of data on 
RocketPort adapters.

User-Friendly Port 
Name

You can enter a custom COM port name to identify this device in the Windows 
Driver Management Console.

COM Name

The COM Name drop list allows you to renumber this COM port. If you see a COM 
port number followed by (in use), this means that Plug and Play sees those COM 
port numbers in use by another device.
DeviceMaster: If you renumber this COM port and click the Renumber All 
Subsequent Ports Relative to The Port option, the device driver will renumber 
all of the ports on the DeviceMaster, starting with the number you select in this 
drop list.
If you rename the port to a COM name used by another port, a dialog appears 
indicating that the port is already in use.

Renumber All 
Subsequent Ports 
Relative to the Port
Default = Disabled

Use the Renumber All Subsequent Ports Relative to This Port option to 
renumber all subsequent ports on the product relative to the port displayed in the 
COM name drop list.

Defaults
Default = Disabled Click the Defaults button to return to the driver default values.

Port Settings General 
Tab Descriptions (Continued)
51



ICDM-RX/TCP (DeviceMaster) and ICRPC (RocketPort EXPRESS) 
Windows Driver Installation
20
24

-0
2

4.7. DeviceMaster Network Configuration

Pepperl+Fuchs recommends using PortVision DX to configure network settings.
Note: Use NS-Link/SocketServer (DeviceMaster web page) to configure IPv6 network settings.
Optionally, you can use the Windows Driver Management Console to:
• Disable IP communications.
• Change the IP address (if the MAC address has been associated to the DeviceMaster), see Changing a 

Static IPv4 Address on Page 53.
• Configure the DeviceMaster for use with DHCP, see Setting Up DHCP (IPv4) on Page 54.

4.7.1. Disabling IPv4 Mode
Use this procedure if you want to disable IP communications.
1. If necessary, access the Windows Driver Management Console.

Note: The DeviceMaster must be operational in MAC mode on a local network segment or connected 
directly to the PC (DeviceMaster Associating the MAC Address on Page 36).

2. Make sure that the MAC Mode radio button has been selected.
3. Highlight the Device Name of the DeviceMaster that you want to 

configure.
4. Click the Network Settings button.
5. Click the Modify button.
6. Click Disable IP. 

You can use the Disable IP option if you are not using IP 
addressing (DHCP or static) and operating the DeviceMaster in 
MAC mode. 

7. Click the Apply Changes button.
8. Click Yes to the Warning popup.
After the DeviceMaster is rebooted, the following occurs:
• In PortVision DX, the IP address displays as 0.0.0.0.
• In the Windows Driver Management Console:

- The IP address in the Network Settings popup displays 
255.255.255.255.

- If the DeviceMaster had been set to IP Mode, the previously programmed IP address will appear in the 
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IP Mode text box. You can delete the IP address from the IP Mode text box and click Apply to clear the 
IP address from the text box.

9. Click Close to return to the Windows Driver Management Console.
After disabling IP communications, you may need to do the following:

• Configure device properties, see Configuring Device Settings on Page 43.
• Configure COM port properties, see Configuring COM Port Properties on Page 47.
• Configure any of the DeviceMaster ports as sockets, see Configuring DeviceMaster Ports as Sockets 

on Page 56.

4.7.2. Changing a Static IPv4 Address 
Typically, PortVision DX is used to program the IP address into the DeviceMaster during initial configuration. 
After associating the DeviceMaster with the MAC address you can change the IP address using the Windows 
Driver Management Console.
1. Before programming an IP address it is critical that the DeviceMaster be operational (the PWR or Status 

LED is lit) when configured for the MAC address (DeviceMaster Associating the MAC Address on Page 36). 
Note: If the DeviceMaster is NOT operational, do NOT attempt to program or use an IP address with the 

DeviceMaster.
2. Highlight the Device Name of the DeviceMaster that you want to 

configure.
3. Click the Network Settings button.
4. Click the Modify button.
5. Click Static IP.
6. Enter static IP address information in the fields below.

a. IP Address: Enter a valid IP address for your network. The IP 
Address field is the IP address programmed into the 
DeviceMaster after applying the changes and rebooting the 
DeviceMaster. See your network administrator for a valid IP 
address.

b. Mask: The subnet mask is a 32-bit value (255.x.x.x) that 
enables IP packets to distinguish the network ID and host ID 
portions of the IP address that filters traffic.

c. Gateway: The default gateway is a TCP/IP configuration item that is the IP address of a directly 
reachable IP router.

7. Click Apply Changes to begin programming the DeviceMaster.
8. Click Yes to the WARNING popup message.

9. Click Yes to the next WARNING popup message about rebooting 
the DeviceMaster.
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If you do not reboot the DeviceMaster at this time, the IP address is not implemented on the DeviceMaster. 
Failure to reboot at this time can cause network communication problems later, if the IP address is not 
programmed into the DeviceMaster. Pepperl+Fuchs support recommends rebooting the DeviceMaster at 
this point.

10. Click Close to return to the Device General tab.
11. Optionally, you can click the Advanced tab and verify that the Device Status message indicates that the 

Device is active and Ok.
12. After programming the IP address, you may need to do the following:

• Configure device properties, see Configuring Device Settings on Page 43.
• Configure COM port properties, see Configuring COM Port Properties on Page 47.
• Configure any of the DeviceMaster ports as sockets, see Configuring DeviceMaster Ports as Sockets 

on Page 56.

4.7.3. Setting Up DHCP (IPv4)
After associating the DeviceMaster with the MAC address you can configure the driver to work using DHCP.
1. Before programming an IP address it is critical that the DeviceMaster be operational (the PWR or Status 

LED is lit) when configured for the MAC address (DeviceMaster Associating the MAC Address on Page 36). 
Note: If the DeviceMaster is NOT operational, do NOT attempt to 

program or use an IP address with the DeviceMaster.
2. Highlight the Device Name of the DeviceMaster that you want to 

configure.
3. Click the IPv4 Mode radio button.
4. Click the Network Settings button.
5. Click the Modify button.

6. Click DHCP IP. This option allows DHCP to assign the IP address. 
Make sure that you provide the MAC address of the DeviceMaster 
for the network administrator to assign a static IP address from 
the pool. The DHCP server should assign the IP address, mask, 
and IP gateway.

7. Click Apply Changes.
8. Click Yes to the WARNING popup message.
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9. Click Yes to the next WARNING popup message.
If you do not reboot the DeviceMaster at this time, the IP address is not 
implemented on the DeviceMaster. Failure to reboot at this time can 
cause network communication problems. Pepperl+Fuchs support 
recommends resetting the DeviceMaster.
After the DeviceMaster reboots, the following occurs:
• The Windows Driver Management Console displays the IP address 

(0.0.0.0) and subnet mask (255.255.0.0) values in the Network Settings popup.
• PortVision DX will display the IP address assigned by DHCP.

10. Click Close to return to the Device General tab.
11. Optionally, you can click the Advanced tab and verify that the Device Status message indicates that the 

Device is active and Ok.
12. After programming the IP address, you may need to do the following:

• Configure device properties, see Configuring Device Settings on Page 43.
• Configure COM port properties, see Configuring COM Port Properties on Page 47.
• Configure any of the DeviceMaster ports as sockets, see Configuring DeviceMaster Ports as Sockets 

on Page 56.
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4.8. Configuring DeviceMaster Ports as Sockets

DeviceMaster ports can also be configured as sockets. To configure sockets, use the following procedure:
1. Use one of these methods to open the socket configuration web interface (SocketServer). 

• In PortVision DX, right-click the DeviceMaster and click Web page.
• Enter the IP address of the DeviceMaster in your web browser URL field or highlight the DeviceMaster 

in PortVision DX and click Web Manager.
2. Click the Port tab and click the port number.
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3. Configure as a socket in the Port page.

See the web page help system, if you need information about configuring sockets or serial tunneling. Optionally, 
you can refer to the ICDM-RX/TCP Installation and Configuration Manual.
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4.9. Enabling Secure Data Mode

In addition to enabling SSL mode in the driver, you must Enable Secure Data Mode in the NS-Link web page. 
Use the following procedure to implement the Enable Secure Data Mode option.
1. Access the NS-Link web page using one of these methods:

• Open your web browser, enter the IP address, and click enter.
• Right-click the DeviceMaster in the Device Tree or Device List pane in PortVision DX and click 

Webpage.
2. Click the Network tab.
3. Click the Security tab.
4. Click Enable Secure Data Mode.
5. Optionally, set other security options and then click Save.

6. Click Keys/Certs to configure your security key and certificate.
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7. Use the Browse button to locate your key or certificate and when you are done, click Save. 

Click the Help button if you need information about key and certificate management.
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5.  Using Driver Configuration Files

5.1. Overview

The Windows Driver Management Console supports saving device driver configuration files, which provides:
• Back-up for existing driver configuration settings
• Ability to configure multiple of the same devices with the same configuration parameters
• Save the driver configuration settings because you need to remove a driver version to install a new driver 

version and you want to reload the driver configuration settings into the new driver
Configuration files are saved with a .DCF extension.

5.1.1. DeviceMaster
Configuration files must be for the same DeviceMaster model with the same port density. For example, you 
cannot load a a configuration file for a 32-port DeviceMaster onto a 4-port  DeviceMaster.

5.1.2. RocketPort
Configuration files must be for the same model with the same port density. For example, you cannot load a 
RocketPort EXPRESS configuration file onto a RocketPort INFINITY.
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5.2. Saving Driver Configuration Files

Use the following procedure to create and save a configuration file.
1. After configuring the device and ports, click Save Configuration.

Note: Saving the device configuration also saves the port configuration parameters.
2. Optionally, change the default file name and click Save.
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5.3. Loading a Driver Configuration File

You must have previously saved a configuration file before you can load a configuration file. The driver 
configuration file uploads in portions:
• If you highlight a device and click Load Configuration and Apply for the device-level configuration 

parameters to reload on the device. 
• To load port-level configuration parameters, you must highlight a single port and click Load Configuration 

and Apply. You must upload each port's configuration parameters separately.

5.3.1. Loading Device Configuration
Use the following procedure to load the configuration file for device-level information for your device. 
1. If necessary, open the Windows Driver Management Console. 
2. Depending on your operating system, you may need to click Yes to the Do you want to allow the following 

program to make changes to this computer? User Account Control message.
3. In the left pane, highlight the device for which you want to load the device-level settings from the 

configuration file.
4. Click Load Configuration.
5. Browse to the location of the configuration file that you want to load.
6. Highlight the configuration file and click Open. The configuration file loads in a few moments. 
7. Make the appropriate choice for your situation:

• Click No to the message, if you are using the file to set up multiple devices with the same device-level 
settings.

• Click Yes to the message, if you are using the file to restore a specific device. 
Note: DeviceMaster: Make sure that if this a configuration from another DeviceMaster, you must either 

select the correct MAC address from the drop list or enter the correct MAC address. In addition, 
make sure that the correct IP associated with this DeviceMaster.

8. Click Apply so that the configuration is saved on the device.
9. Go to the next procedure if you want to restore port settings from a configuration file.
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5.3.2. Loading Port Configuration
Use the following procedure to load the configuration file for port-level settings for your device. 
Note: Device driver configuration files must be for the same model with the same port density. For example, 

you cannot load a configuration file for a 32-port DeviceMaster onto a 4-port or a RocketPort EXPRESS 
configuration file with the same port density onto a RocketPort INFINITY.

1. If necessary, open the Windows Driver Management Console. 
2. Depending on your operating system, you may need to click Yes to the Do you want to allow the following 

program to make changes to this computer? User Account Control message.
3. In the left pane, highlight the port for which you want to load the port-level settings from the configuration 

file.
4. Click Load Configuration.
5. Browse to the location of the configuration file that you want to load.
6. Highlight the configuration file and click Open. The configuration file loads in a few moments. 
7. Make the appropriate choice for your situation:

• Click No to the message, if you are using the file to set up multiple devices with the same port-level 
settings.

• Click Yes to the message, if you are using the file to restore a specific device. 

Note: Make sure that you do not duplicate COM port numbers. Simply change the COM port number 
assignment before applying the changes.

8. Click Apply so that the configuration is saved on the device.
9. Repeat Steps 3 through 8 for each port that you want to restore.
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6.  Removing the Device and Driver

This section discusses:
• Removing an RocketPort or DeviceMaster from an installation without removing the device driver from your 

system
• Removing the Device Driver and Device from your system

6.1. Removing a Device from Installation - Keeping the Device Driver

Use the following procedure to uninstall the device driver.
Note: Administrative privileges are required to remove device drivers.
1. Right-click the DeviceMaster or RocketPort that you want to uninstall in the Tree View pane of the Windows 

Driver Management Console.
2. Click Uninstall.
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6.2. Removing the Device Driver and Device

Use the following procedure to remove the device driver.
1. From the Start button, click the shortcut for your device: Pepperl+Fuchs > Product > Driver Installation 

Wizard.
2. Click Yes to the Do you want to allow this app to make changes to your device? message.
3. Click Next to start the Pepperl+Fuchs Driver Installation Wizard.

4. Click Remove All and Next.
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5. Click Next to clean up the driver removal.

6. Click Proceed to continue the driver removal process.

7. Click the Reboot My Computer button or Close.

• If you click Close, make sure that you reboot the system and remove the RocketPort from the system 
or DeviceMaster from the network to complete the driver removal.
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• If you click Reboot My Computer, click Ok. Remove the RocketPort from the system or DeviceMaster 
from the network to complete the driver removal.

8. If you want to totally remove the .exe driver assembly:
a. Delete any copies of the .exe driver assembly file residing on the system.
b. Delete the driver and devices using the Add > Remove Programs Control Panel.
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7.  Troubleshooting and Technical Support

This section contains troubleshooting information for the DeviceMaster and the RocketPort device driver for 
Windows. Review the following subsections before calling Technical Support because they will request that 
you perform many of the procedures or verifications before they will be able to help you diagnose a problem.
• DeviceMaster Troubleshooting on Page 70
• Using Test Terminal on Page 81
• Using Port Monitor to Test Ports on Page 92
• How Disable/Enable the Device Driver on Page 95
If you cannot diagnose the problem, you can contact Technical Support on Page 95. 

7.1. Download Diagnostic Applications

There are several tools and utilities that Pepperl+Fuchs provides to diagnose serial port problems or to monitor 
data.
Go to https://www.pepperl-fuchs.com and locate the product and download the applications or utilities.

7.1.1. RocketPort
The RocketPort provides a utility package that includes two diagnostic tools. See RocketPort Installing Test 
Terminal and PortMon on Page 79. 
• Test Terminal use to troubleshoot communications on a port-by-port basis. See Using Test Terminal on 

Page 81
• Port Monitor check for errors, modem control, and status signals. In addition, it provides you with raw byte 

input and output counts. See Using Port Monitor to Test Ports on Page 92

7.1.2. DeviceMaster
The DeviceMaster provides the following diagnostic tools and utilities.
• The Advanced tab in the Windows Driver Management Console (Using the Advanced Tab on Page 73), 

which may provide valuable information about the DeviceMaster and your network, in the event that you are 
having problems.

• PortVision DX that provides the following features:
- Auto-discover and organize the following Ethernet attached productss on your network. 
- Remotely access, manage, and configure the following Ethernet attached productss from a central 

console. 
- Load network configuration settings onto multiple the following Ethernet attached productss - quickly 

and easily. 
- Instantly view connection status, firmware revision, and network settings of all servers. 
- Configure serial ports using TCP sockets, port communication, and interface settings. 
- Visualize each server and port with instant links to connector, power, and serial pinout information. 
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- Conveniently customize and save your network view and commands for replication across all servers. 
- Includes the Test Terminal (WCom2) and Port Monitor (PMon2) programs for easy access.

- Test Terminal can be used to troubleshoot communications on a port-by-port basis. Refer to Using 
Test Terminal on Page 81 for more information.

- Port Monitor can check for errors, modem control, and status signals. In addition, it provides you 
with raw byte input and output counts. Refer to Using Port Monitor to Test Ports on Page 92 for more 
information.

7.2. RocketPort Troubleshooting

If you are having trouble with a RocketPort installation, try the following.
Note: Most customer problems reported are traced to cabling or network problems.

Issue Troubleshooting

Correct cabling?
Verify that you are using the correct types of cables in the correct places and 
that all cables are tightly connected. Refer to the ICRPC and ICRPB (RocketPort 
EXPRESS) Hardware Installation Manual to verify cabling.

Correct Port Addressing?
Verify that you are addressing the port correctly. In many applications, device 
names above COM9 require the prefix \\.\ to be recognized. For example, to 
reference COM20, use \\.\COM20 as the file or port name.

Windows Driver 
Management Console?

Verify that the RocketPort has installed using the Windows Driver Management 
Console to confirm that the adapter displays. Install the device driver, if the 
adapter is not displayed.

Test the Port or Ports? Install the Utility (RocketPort Installing Test Terminal and PortMon on Page 79) 
and use Test Terminal (Using Test Terminal on Page 81).

Is this the Latest Driver? See Checking the Device Driver Version on Page 23.

Port Does Not Open?

1. Open the Device Manager. 
2. Double-click Ports (COM & LPT) to expand the view.

Ports are displayed in the Device Manager as RocketPort EXPRESS/
INFINITYUnity ports

If a yellow exclamation mark represents the port, right-click on the exclamation 
mark, and click Update Driver. See Updating the Device Driver on Page 23 for 
detailed procedures.

Monitor Port Activity? Install the Utility (RocketPort Installing Test Terminal and PortMon on Page 79) 
and use Port Monitor (Using Port Monitor to Test Ports on Page 92).

Enable Verbose mode

You can optionally enable the Verbose Event Log option on the Device General 
tab for diagnostic purposes to initiate longer messages to be sent to the Event 
Log for your operating system. The added information can be useful when 
debugging communications and configuration problems.
Access the event log through the Administrative Tools Event Viewer option.
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7.3.  DeviceMaster Troubleshooting

Most customer problems reported to Pepperl+Fuchs Technical Support are eventually traced to cabling or 
network problems.
Reboot the system and reset the power on the DeviceMaster, watch the PWR or Status light activity. See 
DeviceMaster LEDs on Page 72 for information about the diagnostic LEDs.
• If the DeviceMaster has a power switch, turn the power switch off and on. 
• If the DeviceMaster does not have a power switch, disconnect and reconnect the power cord.

7.3.1. DeviceMaster Checklist
 The following table may help you diagnose the problem. If you have a spare, you can replacing it to see if that 
resolves the issue. 

PWR or Status LED Description
5 sec off, 3 flashes, 5 sec off, 3 flashes ... Redboot checksum failure.
5 sec off, 4 flashes, 5 sec off, 4 flashes ... SREC load failure.
5 quick flashes The default application is starting up.
10 sec on, .1 sec off, 10 sec on .1 sec off ... The default application is running.

Issue Check

Cabling?
Verify that you are using the correct types of cables on the correct connectors and that all 
cables are connected securely using the ICDM-RX/TCP Installation and Configuration 
Manual.

Correct MAC 
address?

Verify that the hardware MAC address in NS-Link matches the address on the 
DeviceMaster label. You can also use PortVision DX to verify the MAC and IP addresses.

Network?

• Isolate the DeviceMaster from the network by connecting the DeviceMaster directly to 
a NIC in a host system. 

• See DeviceMaster Connectivity Requirements on Page 72 for network cabling 
information. 

• Reduce network traffic by installing a second NIC in the host and connect directly to 
the DeviceMaster. 

• Verify that the Ethernet hub, switch, or router and any other network devices between 
the system and the DeviceMaster are powered up and operating.

Correct IP 
address?

• Verify that the network IP address is correct. If IP addressing is being used, the 
system should be able to ping the DeviceMaster.

• Verify that the IP address programmed into the DeviceMaster matches the unique 
reserved IP configured address assigned by the system administrator.

Correct port 
addressing?

If using the NS-Link device driver with an in-house application, verify that you are 
addressing the port correctly. In many applications, device names above COM9 require 
the prefix \\.\ in order to be recognized. For example, to reference COM20, use \\.\COM20 
as the file or port name.

Is this the 
Latest Driver? See Checking the Device Driver Version on Page 23.
Test the Port or 
Ports? Install PortVision DX (Page 9) and use Test Terminal (Page 81).
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7.3.2. DeviceMaster General Troubleshooting
This table illustrates some general troubleshooting tips.

Windows Driver 
Management 
Console?

Verify that the DeviceMaster has installed using the Windows Driver Management 
Console to confirm that the DeviceMaster displays. Install the device driver, if the 
DeviceMaster is not displayed.

Enable 
Verbose mode

Enable the Verbose Event Log feature on the Device General and then reboot the 
system.

General Condition Explanation/Action

PWR or Status LED 
flashing

Indicates that boot program has not downloaded to the DeviceMaster.
1. If applicable, remove the NS-Link driver.
2. Make sure that you have downloaded the latest driver.
3. Install the driver and configure the DeviceMaster using the MAC address. 

Make sure that you reboot the system. Refer to Device Driver Installation on 
Page 17 for installation information.
Note: If the PWR or Status LED is still flashing, contact Technical Support.

PWR or Status LED not lit Indicates that power has not been applied or there is a hardware failure. Contact 
Technical Support.

Can ping the 
Pepperl+Fuchs device, 
but cannot open the ports 
from a remote location. 
(You must have previously 
programmed the IP 
address, subnet mask, 
and IP gateway.)

The NS-Link driver uses Port 4606 (11FE h) to communicate with the 
DeviceMaster. 
When using a sniffer to track NS-Link packets, filtering for Port 4606 will easily 
track the packet. The packet should also contain the MAC address of the 
DeviceMaster and the originating PC so that it can be determined if the packet is 
able to travel the full distance one way or not. 
If the 4606 packet is found on one side of a firewall or router, using sniffer, and 
not on the other side, then that port needs to be opened up to allow the 4606 to 
pass. 
This will most often be seen with firewalls, but is also seen in some routers.

Cannot ping the device 
through Ethernet hub, 
switch, or router

Isolate the DeviceMaster from the network. Connect the DeviceMaster directly to 
the NIC in the host system (see DeviceMaster Connectivity Requirements on 
Page 72).

Cannot ping or connect to 
the DeviceMaster

The DeviceMaster family default IP address is often not accessible due to the 
subnet masking from another network unless 192.168 is used in the network. 
In most cases, it will be necessary to program in an address that conforms to 
your network. 
If you do not use the NS-Link driver to program the IP address, you only have 10 
seconds to disable the bootloader with Redboot to get into the setup utility. 
See the ICDM-RX/TCP Installation and Configuration Manual Installation and 
Configuration Guide for the Redboot method of programming an IP address.

Issue Check
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7.3.3. DeviceMaster Connectivity Requirements
An Ethernet connection: either to an Ethernet hub, switch, or router; or to a Network Interface Card (NIC) in the 
host system using a standard Ethernet cable. See the ICDM-RX/TCP Installation and Configuration Manual 
Installation and Configuration Guide for information regarding hardware installation.

7.3.4. DeviceMaster LEDs
The DeviceMaster has network and port LEDs to indicate status.
7.3.4.1.   Port LEDs

The 1-port and 2-port models do not have port LEDS. 
4, 8, 16, and 32-port models have port LEDs are amber and green. After a port has been opened in RS-232 
mode, an amber LED means that there is link between the port and the serial device. After a port has been 
opened in RS-422 or RS-485 mode, an amber LED means that data is receiving data. A green port LED 
indicates transmit activity.
7.3.4.2.   Network and Device LEDs

The LEDs indicate that the default DeviceMaster application, NS-Link/SocketServer is running or after driver 
installation, that the NS-Link driver loads. If you have loaded PortVision DX, you can check the DeviceMaster 
status on-line.

DeviceMaster Port Density Connected to Connector Name
1-port Hub, switch, router, or NIC 10/100 ETHERNET
2-port Hub, switch, router, or NIC 10/100

4/8/16-port (external power supply) NIC DOWN
Hub, switch, or router UP

16/32RM (internal power supply) Hub, switch, router, or NIC 10/100 NETWORK

Ports DeviceMaster Network LEDs

1

• The Status LED on the front of the unit is lit, which indicates that it has power and has 
completed the boot cycle.
Note: The Status LED flashes while booting and it takes approximately 15 seconds 

for the bootloader to complete the cycle. When the Bootloader completes the 
cycle, the LED has a solid, steady light that blinks approximately every 10 
seconds.

• The red Link Act LED is lit, which indicates a working Ethernet connection.
• If the red Duplex LED is lit, it indicates full-duplex activity.
• If the red 100 LED is lit, it indicates a working 100 MB Ethernet connection (100 MB 

network, only).
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7.3.5. Using the Advanced Tab
You can use the Advanced tab to get a summary of the DeviceMaster status. The Advanced tab can be useful 
for troubleshooting network problems with your DeviceMaster.
Note: To use the Advanced tab, you must associate a MAC address to the DeviceMaster before 

programming an IP address (Page 36).
Use the following procedure to access the Advanced tab.
1. If necessary, access the Windows Driver Management Console.
2. Highlight the DeviceMaster.

2

• The STATUS LED on the device is lit, indicating you have power and it has completed 
the boot cycle.
Note: The STATUS LED flashes while booting and it takes approximately 15 seconds 

for the Bootloader to complete the cycle. When the Bootloader completes the 
cycle, the LED has a solid, steady light that blinks approximately every 10 
seconds.

• If the LINK (green) LED is lit, it indicates a working Ethernet connection.
• If the ACT (yellow) LED flashes, it indicates network activity.

4, 8,16
External power 

supply

• The PWR LED on the front of the unit is lit, which indicates it has power and has 
completed the boot cycle. 
Note: The PWR LED flashes while booting and it takes approximately 15 seconds for 

the bootloader to complete the cycle. When the Bootloader completes the 
cycle, the LED has a solid, steady light that blinks approximately every 10 
seconds.

• The red LNK/ACT LED is lit, which indicates a working Ethernet connection.
• If the red 100 LED is lit, it indicates a working 100 MB Ethernet connection (100 MB 

network, only).

16, 32
Internal power 

supply

• The Status LED on the front of the unit is lit, which indicates it has power and has 
completed the boot cycle. 
Note: The Status LED flashes while booting and it takes approximately 15 seconds 

for the bootloader to complete the cycle. When the Bootloader completes the 
cycle, the LED has a solid, steady light that blinks approximately every 10 
seconds.

• The red LNK/ACT LED is lit, which indicates a working Ethernet connection.
• If the red Duplex LED is lit, it indicates full-duplex activity.
• If the red 100 LED is lit, it indicates a working 100 MB Ethernet connection (100 MB 

network, only).

Ports DeviceMaster Network LEDs
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3. Click the Advanced tab.

Note: You must have previously associated a MAC address to the DeviceMaster (Page 36).
Refer to the Device Status table (Page 76) for a list of messages and explanations.

4. You can click the History button to review the last ten actions on the DeviceMaster.

5. Click PC Network Interface Details for the following information. 

Field PC Network Interface Details Description 

MAC Address
MAC Address is the reported MAC address of the Ethernet network interface card (NIC) 
card in the server. Since a server may contain more than one NIC, identifying exactly 
which NIC is being used by the device driver may help you to identify and resolve 
problems.

Frames Out
Frames Out is the count of the number of frames output by the device driver through the 
identified network interface. This includes all administrative, data, and control frames, 
and should be incriminated whenever the DeviceMaster and the device driver are 
operating, even if the DeviceMaster is idle.
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6. Click Close to return to the Advanced tab.
7. Click the Device Network Interface Details button to review the following information. 

Frames 
Accepted

Frames Accepted is the count of the number of received frames accepted by the device 
driver for further processing. These must be well-formed packets with the correct 
protocol identifiers for the device driver.

Frames Passed 
On

Frames Passed On is when a NIC receives a packet, it passes the packet around to 
each driver or application that is bound to the NIC until one of them recognizes and 
accepts the packet.

Adapter 1 ID 
String

Adapter 1 ID String is the NIC binding string. Every network entity that needs to be 
uniquely identified has a Globally Unique Identifier (GUID), which is used to form unique 
binding strings. The presence of this string indicates that the device driver has been 
bound to a specific NIC.

Reset This button resets the statistics in the PC Network Interface window.

Fields Device Network Interface Details Descriptions 

MAC Address
MAC Address is the network (MAC) address of the DeviceMaster that is currently 
selected. It should match both the MAC address on the General tab and the MAC 
address on the physical DeviceMaster.

Packets To Packets To is the count of information frames sent to a layer in the device driver and 
indicates actual data traffic sent.

Packets From Packets From is the count of information frames received by a layer in the device 
driver, and indicates actual data traffic received.

Retransmitted/% All 
Sent

Retransmitted/% All Sent is the percentage of information frames requiring 
retransmission due to network errors. If this value is not zero, you may have network 
problems.

Reported State Reported State contains a message showing the status of the device driver to the 
selected DeviceMaster.

Devices Detected/
Available

Devices Detected/Available is the number of DeviceMasters found on the network and 
how many of the DeviceMasters are available.

Field PC Network Interface Details Description (Continued)
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8. Click Close to return to the Advanced tab.
The following table provides a list of Device Status messages.

Out of Sequence/ % 
of All Received

Out of Sequence/ % of All Received is the percentage of information frames received 
out of order, possibly due to network errors. If this value is not zero, you may have 
network problems.

Maximum Average 
Buffer Usage

Maximum and Average Buffer Usage is the percentage of the network buffer used 
since the driver was loaded.

Buffer Allocation 
Failures

Buffer Allocation Failures displays how many times the driver failed to allocate network 
buffers to the process because there were not enough buffers.

Starving Port(s) If any Buffer Allocation Failure happens, the Starving Port(s) list will include the name 
of the COM port that could not be serviced (immediately) because of it.

Reset Reset clears the data values from the fields. and updates the data displayed in the 
event that you want review data before the automatic refresh cycle occurs.

Device Status Message Descriptions 
A MAC address has not yet been specified 
for this device. Return to the General tab, 
configure the device, and apply the 
changes.

The driver may have only been configured with an IP address. 
The appropriate MAC address must be input in the MAC field 
in the General tab so that the Advanced tab can report 
DeviceMaster status.

Can't detect any Pepperl+Fuchs devices. 
Check Ethernet connectors and ensure the 
device is powered on.

Network traffic is being received, but not from a DeviceMaster. 
Check the network connections and verify that the 
DeviceMaster is powered up.

Can't detect the device with specified the 
MAC address on any network. Verify the 
MAC address of the unit, check the Ethernet 
connectors and ensure the device is 
powered on.

Network traffic is being received from a DeviceMaster, but not 
the one specified on the General tab. Check the DeviceMaster 
to make sure that you are using the correct MAC address.

Code upload failed due to a timeout and the 
driver is attempting to re-synchronize with 
the device.

The device driver has not successfully uploaded the firmware 
to the assigned DeviceMaster.

Code upload has completed. The driver has completed uploading the firmware to the 
DeviceMaster.

Code upload was restarted after a timeout. The firmware upload process failed due to a time-out. The 
upload process has been restarted.

Device detected, initializing. The server has acquired the DeviceMaster and is downloading 
the control program. The device will be available shortly.

Device detected, microcode upload in 
progress.

The device driver is attempting to upload the microcode to the 
DeviceMaster. This should complete momentarily.

Device is active and OK, no data traffic was 
exchanged since last inquiry.

The DeviceMaster and ports are operational. There is currently 
no active serial traffic.

Device is active and OK. The DeviceMaster is okay and ready to use.
Device is detected and configured in the 
driver, but is not yet assigned to this server/
PC.

Either the DeviceMaster is currently being controlled by 
another server or the DeviceMaster power has been cycled 
and the DeviceMaster is waiting for a server to acquire it.

Fields Device Network Interface Details Descriptions (Continued)
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Excess out-of-sequence packets received. 
Check for indications of high network traffic.

Click the PC Network Interface Details button to review the 
statistics, which may indicate that DeviceMaster is functioning 
properly. 
This message typically goes away on it's own but you can 
reboot the PC so that the network traffic is re-synchronized.

Excess packet retransmissions detected. 
Check for indications of high network traffic.

Click the PC Network Interface Details button to review the 
statistics, which may indicate that DeviceMaster is functioning 
properly. This message typically goes away on it's own but you 
can reboot the PC so that the network traffic is re-synchronized 
or reset the counters, which may cause the Advisor to change 
from Excess Packets to Ok.
If this does not cause the DeviceMaster to go Active and Ok, 
then it is likely that there is a network issue involved that should 
be corrected.

Initialization complete. Waiting on response 
from the device before making the 
connection active.

Waiting for a response from the DeviceMaster.

Statistical data was reset.
This indicates the number of times that the statistics in the PC 
Network Interface and Device Network Interface have 
been reset.

The driver is not running. If you just installed 
the driver you will need to exit the program 
before the driver starts.

Close and then re-open the Windows Driver Management 
Console.

The communications between the driver 
and the device has been disrupted. Check 
connectors, cabling, and look for indications 
of high network traffic.

The DeviceMaster is off-line in this state. The MAC or IP 
address for the DeviceMaster is known (assigned) but 
communications have been interrupted.

The device has failed to respond for an 
extended period of time. The device may 
have lost power or is in an unresponsive 
state.

The device driver is no longer able to communicate with the 
DeviceMaster. Check the LED status (Page 72).

The driver is not running. Make sure the 
driver is installed correctly and restart the 
PC to correct the problem.

Make sure the driver is installed correctly and restart the PC to 
correct the problem. The driver is most likely disabled. Enable 
the driver and reboot the PC.

Timeout occurred while the driver was 
waiting for an ADMIN command reply from 
the device.

There may be network traffic problems, an unresponsive 
DeviceMaster, or a problem with the server sending out 
network data. 
The device driver is trying to locate the DeviceMaster on the 
network by sending out the ID request and not receiving a 
response from the DeviceMaster, which may indicate that the 
DeviceMaster is either not on the network, on a different 
segment (if using MAC mode of addressing), or the bandwidth 
of the network (or server) is so saturated that the 
DeviceMaster response is not received in time.

Timeout occurred while the driver was 
waiting for an Assign Reply response from 
the device prior to making the connection 
active.

There may be network traffic problems, an unresponsive 
DeviceMaster, or a problem with the server sending out 
network data. A handshake that occurs after an ID response is 
received and the device driver is trying to establish a 
communication channel with the DeviceMaster.

Unable to find a Network Interface 
Controller (NIC) card. Install a NIC in that PC or check that the NIC is operational.

Device Status Message (Continued) Descriptions (Continued)
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7.3.6. NS-Link Driver Troubleshooting
This table includes some tips related to NS-Link drivers for Windows.

Uninitialized.
The firmware has not uploaded to the DeviceMaster. If this 
message is displayed in the History file, it often means that the 
DeviceMaster is in the process of being rebooted.

NS-Link Condition Explanation/Action

Need to program IP 
address into the device.

Before programming an IP address it is critical that the DeviceMaster be 
operational and passes the power on tests when configured for the MAC 
address. 
Note: If the DeviceMaster is NOT operational, do NOT attempt to program or 

use an IP address with the DeviceMaster.
See Program the IPv4 Address (Network Information) on Page 12 for more 
information.

Cannot open port

1. Verify that MAC address in the NS-Link driver matches the address on the 
DeviceMaster.

2. Verify that you are using the correct NS-Link driver. If necessary, remove 
and reinstall a new driver.

3. Isolate the DeviceMaster from the network (see Page 71).
4. Check to see if another program or computer is active on this port.

The Pepperl+Fuchs device 
has a lower limitation of 
network bandwidth 
requirement of 64 Kbps. 

At this speed the entire available bandwidth is required for the purpose of 
uploading the firmware from the driver to the DeviceMaster. At lower speeds, 
timing issues will prevent the firmware from being successfully installed to the 
DeviceMaster, thus preventing the DeviceMaster from normal operation.
When using the DeviceMaster over a WAN link that is less than the 
recommended 64 Kbps, a timing modification may be made that will allow 
uploading of the firmware.
Load the driver locally to the DeviceMaster for the purpose of getting the 
firmware installed. The PC on the other side of the slow link can then “share” the 
port. The sharing may be exclusive as the firmware loader PC may not need to 
access the ports.

Device Status Message (Continued) Descriptions (Continued)
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7.4. RocketPort Installing Test Terminal and PortMon

Use this procedure to install Test Terminal and PortMon for RocketPort diagnostic tools.
1. Download from https://www.pepperl-fuchs.com by accessing your product page.
2. Extract the .zip file and execute the .msi file.
3. Click Next.

4. Click Next.
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5. Click Install.

6. Click Yes to the Do you want to allow this app to make changes to your device?
7. Click Finish.
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7.5. Using Test Terminal

Test Terminal (WCom2) allows you to open a port, send characters and commands to the port, and toggle the 
control signals. This application can be used to troubleshoot communications on a port-by-port basis. 
• Send and Receive Test Data: This sends data out the transmit line to the loopback plug, which has the 

transmit and receive pins connected thus sending the data back through the Rx line to Test Terminal, which 
then displays the received data in the terminal window for that port. This test is only testing the Tx and Rx 
signal lines and nothing else. This test works in either RS-232 or RS-422 modes as both modes have 
transmit and receive capability. A failure in this test will essentially prevent the port from working in any 
manner.

• Loopback Test: This tests all of the modem control signals such as RTS, DTR, CTS, DSR, CD, and RI 
along with the Tx and Rx signals. When a signal is made HI in one line the corresponding signal line 
indicates this. The Loopback Test changes the state of the lines and looks for the corresponding state 
change. If it successfully recognizes all of these changes, the port passes. 
A failure on this test is not necessarily critical as it will depend on what is connected and how many signal 
lines are in use. For example, if you are using RS-232 in 3-wire mode (Transmit, Receive and Ground) a 
failure will cause no discernible issue since the other signals are not being used. If the port is configured for 
use as either RS-422 or RS-485 this test will fail and is expected to fail since RS-422 and RS-485 do not 
have the modem control signals that are present in RS-232 for which this test is designed.

Test Terminal (WCom2) allows you to open a port, send characters and commands to the port, and toggle the 
control signals. This application can be used to troubleshoot communications on a port-by-port basis. 
The following procedures require a loopback plug to be placed on the port or ports that you want to test.  A 
loopback plug was shipped with your product. If you need to build a replacement or additional loopback plugs 
refer to the appropriate manual at https://www.pepperl-fuchs.com.

7.5.1. Starting Test Terminal
Use the following information to start Test Terminal.
• RocketPort: Test Terminal is included in the Utility package. After installation, start Test Terminal from the 

Start button.

• DeviceMaster: Test Terminal is included with PortVision DX. After PortVision DX is installed, click Tools > 
Applications > Test Terminal (WCom2).
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7.5.2. Opening Ports
The following procedure shows how to use Test Terminal to send and receive test data to the serial ports. 
1. Stop all applications that may be accessing the ports such as RRAS or any faxing, or production software. 

See the appropriate help systems or manuals for instructions on stopping these services or applications. 
If another application is controlling the port, then Test Terminal will be unable to open the port and an error 
message will be shown.

2. Start Test Terminal (WCom2) using Starting Test Terminal on Page 81 .

3. Use the appropriate subsection to open and start testing RocketPort - Opening Ports on Page 82 or 
DeviceMaster - Opening Ports on Page 83.

7.5.2.1.   RocketPort - Opening Ports

1. Select File > Open Port, the appropriate port (or ports) from the Open Ports drop-down list and Ok.

2. Go to the next procedure to send and receive test data.
• Sending and Receiving Test Data (RS-232/422 and RS-485: 4-Wire) on Page 88
• Sending and Receiving Data (RS-485: 2-Wire) on Page 89
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7.5.2.2.   DeviceMaster - Opening Ports

1. Select File > Open Port, the appropriate port (or ports) from the Open Ports drop-down list, enter the IP 
address and click Ok.

a. If necessary to support SSL, open Edge > Settings and select Privacy, search, and services.

b. Click Manage certificates.
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c. Click Import.

d. Click Next.
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e. Browse to the appropriate certificate.

f. Click Next.
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g. Enter the password and click Next.

h. Click Next.
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i. Click Finish.

j. Click the Secure Data (SSL) option.

2. Go to the next procedure to send and receive test data. Use the appropriate procedure:
• Sending and Receiving Test Data (RS-232/422 and RS-485: 4-Wire) on Page 88
• Sending and Receiving Data (RS-485: 2-Wire) on Page 89
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7.5.3. Sending and Receiving Test Data (RS-232/422 and RS-485: 4-Wire)
You can use this procedure to send and receive test data through the RS-232/422/485 (4-wire, full-duplex) port 
or ports that you want to test.
1. If you have not done so, open the port(s) to test.
2. Install the loopback plug onto the port (or ports) that to test.

See the ICDM-RX/TCP Installation and Configuration Manual or ICRPC and ICRPB (RocketPort 
EXPRESS) Hardware Installation Manual, if you need to build loopback plugs.

3. Select Port > Send and Receive Test Data.
You should see the alphabet scrolling across the 
port. If so, then the port installed properly and is 
operational. 
Note: If you left Port Monitor running, it should 

show data sent and received and show 
the average data throughput on the port.

4. Select Port > Send and Receive Test Data to 
stop the scrolling data.

5. You can go to the next procedure to run the 
Loopback Test on Page 88 if this is an RS-232 
port.

If this test successfully completed, then the port is 
operational as expected.
Note: Do NOT forget to restart the communications 

application.

7.5.4. Loopback Test (RS-232)
The Loopback Test tests the modem control (hardware handshaking) signals. It only has meaning in RS-232 
mode on serial connector interfaces with full RS-232 signals. If performed under the following conditions, the 
test will always fail because full modem control signals are not present:
• RS-422
• RS-485
• RJ11 connectors
Use the following steps to run the Loopback Test.
1. If necessary, start Test Terminal.
2. Click Port > Loopback Test.

This is a pass fail test and will take a second or two to complete. Repeat for each port that needs testing.
If the Loopback Test and the Send and Receive Test Data tests successfully complete, then the port is 
operational as expected.
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7.5.5. Sending and Receiving Data (RS-485: 2-Wire)
This procedure shows how to use Test Terminal (WCom2) to test two RS-485 (2-wire, half-duplex) ports.
1. Start Test Terminal.
2. Open two ports RS-485 ports. This example uses COM40 and COM41.

Test Terminal will open two windows, note that both ports show Receiving on the status bar.

3. Right-click both COM windows and remove the check mark for Receive.
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Both COM ports show Ready on the status bar.

4. Right-click in ONE window and select the Receive option from the pop up.
5. Right-click the OPPOSITE window and click Send.

The Status line shows Sending or Receiving.
In this case, COM40 is sending data and COM41 is receiving the data which is visually confirmed by the 
data scrolling across the COM41 window.
Note: If you do not see the data being received it MAY be necessary to also disable the RTS and DTR 

options from the right-click pop-up menu in each COM port.
6. Right-click and remove the check mark on the Sending COM port.
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7. Right-click and remove the check mark on the Receiving COM port.

Neither COM port is sending or receiving data but shows Ready on the Status bar.
8. Reverse the sending/receiving windows one at a time. Set the Receive option first, then in the opposite 

window, select the Send option.
The Status line shows Sending or Receiving in the reverse windows.

Data is now scrolling in the COM40 window. COM41 is static as it is not receiving data but transmitting data.
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7.6. Using Port Monitor to Test Ports

This procedure will check whether the DeviceMaster or RocketPort can:
• Communicate through the device driver 
• Determine if a port is open with an application
1. Open Port Monitor.

• DeviceMaster: Open PortVision DX and start Port Monitor by clicking Tools > Applications > Port 
Monitor (PMon2).

• RocketPort: Open Port Monitor under Start.

2. Click Add Ports using the icon or Tools > Add Ports, 
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3. Click Driver, select the appropriate product and click Ok.

Note: RocketPort / RocketModem are legacy products.
4. If the DeviceMaster is communicating with the device driver for Windows, Port Monitor should display 

CLOSED status. If a port is open for an application, it displays as OPEN, and displays Actual 
Throughput, TxTotal and RxTotal statistics. 

Normally, there should be no data errors recorded or they should be very small. To find out what the actual 
errors are, scroll to the right. You will see three columns: Overrun Errors, Framing Errors, and Parity 
Errors.
If the errors are:
• Overrun Errors represent receive buffer overflow errors. If this is the case, you will have to configure 

either software or hardware handshaking to control the flow of data. The most common errors are 
Overrun errors.

• Framing Errors indicate that there is an synchronization error between the beginning of a data frame 
and the end of the data frame. A frame usually consists of a start bit, 8 data bits, and a stop bit or two. 
The framing error occurs if the stop bit is not detected or it occurs in the wrong time frame. Most causes 
for framing errors are electrical noise on the data lines, or differences in the data clocks of the 
DeviceMaster and the connected device.

• Parity Errors occur when parity is used and the parity bit is not what is expected. This can also be 
caused by noise on the data lines.
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5. You can view additional statistics to Port Monitor by adding columns. Click Tools and Add Columns.

6. Highlight or shift-click to add multiple statistics and click Ok.

Note: See the Port Monitor help system if you need an explanation of a column.
7. Scroll to the right to view the new columns. 

8. If you want to capture this session, you can save a current session as a report. To do this, select one of the 
following save options:
• File > Save As 
• File > Save - if the report already exists in an older format
• Save Active Session  button
Reports can be opened, viewed and re-used when needed. To open and view a report: 
a. Select File > Open or the Open Existing Session  button. The Open Session dialog appears.
b. Locate the session (table), you want to open and click the Open button.
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Optionally, if you want to continue monitoring for an existing session, you need to activate the Polling 
Interval. 
• Select Tools > Settings to access the PMon2 Settings dialog
• Change the Polling Interval field to a value other than zero (0)

9. Leave Port Monitor open so that you can review events when using Test Terminal to test a port or ports.

7.7. How Disable/Enable the Device Driver

Use this procedure to disable or enable the driver for a specific DeviceMaster or RocketPort.
1. Right-click the device that you want to disable (or re-enable) in the Windows Driver Management Console.
2. Click Disable (or Enable).

7.8. Technical Support

If you need technical support, contact Pepperl+Fuchs.
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